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The Fluent Interface, used by all applications, replaces the older menu sys-
tem. It is comprised of The Ribbon, Tabs, Groups and Commands 

THE RIBBON is contains: 

TABS, which are similar to the old menu system. Some tabs do not ap-
pear until an object is selected (working with Smart Art, graphics or 
table, click on that object and a new tab will appear with options for 
that object. 

GROUPS, which contain tasks grouped together in logical, task ori-
ented categories, such as Font or Paragraph. Many Groups now con-
tain Styles Galleries, collections of design elements.  

COMMANDS, the individual buttons, boxes and  
options that you use to perform tasks 

THE OFFICE BUTTON replaces the File Menu. The circle in the upper left cor-
ner of the Ribbon is the Office Button lives. Click once to open, then just 
hold the cursor over the options to view. When you are ready, click to per-
form the action. 

All of these together are the Fluent Interface. It was designed based on 
many focus groups of real people who do the same work that you and I do 
using Office. 
  

Excel 2007 was created to be more powerful than the previous versions of 
Excel, yet organized in a way that is intuitive and useful. Stop. Think about 
what you want to do. If you want to use a chart, select the Insert tab. Pre-
pare and check your document before you print it with the Review Tab. De-
sign how the page looks or prints? Page Layout. The Fluent Interface is now 
as organized as you are (or as you always wanted to be)! 
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The new file formats of Excel 2007: 

EXCEL WORKBOOK (*.xlsx). Use when there are no macros or VBA code.  

EXCEL MACRO-ENABLED (*xlsm) Save your workbook as this file type when 
the workbook contains macros or VBA code. 

EXCEL TEMPLATE (*.xltx). Save your workbook as this file type when you 
need a template.  

EXCEL 97-EXCEL 2003 WORKBOOK (*.xls). Use when you need to share with 
someone working in a previous version of Excel. 

MICROSOFT EXCEL 5.0/95 WORKBOOK (*.xls). Use when you need to share 
with someone using Microsoft Excel 5.0. (while the earlier versions of Of-
fice share the same extension - .xls - they are not the same format.  

EXCEL MACRO-ENABLED TEMPLATE (*.xltm). Use when you need a template 
and the workbook contains macros or VBA.   

EXCEL BINARY WORKBOOK (*.xlsb). Save your workbook as this file type 
when you have an especially large workbook;; this file type will open 
faster for a very large Excel Workbook . You’ll still have the new Excel 
features with this file type, but not it doesn't use XML.  

PDF – Microsoft Office has an add-in that allows you to save a file as a 
PDF document, allowing for cross-compatibility with virtually any operat-
ing system or office suite.
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BENEFITS OF USING THE 2007 FORMAT 

Workbooks are compressed; file sizes are approximately 50% to 75% 
smaller than in previous versions of Excel. In addition, files are more eas-
ily recovered and less prone to corruption in XML. 

 At the same time that the file sizes are smaller spreadsheets can be sig-
nificantly larger. 

More can be done with the data. Because the basis of the document is 
XML (Extensible Markup Language), it is easier to use in the other Office 
programs. 
 

SAVING BACK AND FORTH FROM FORMAT TO FORMAT 

Using the Office Button is the easiest way to save back and forth.  

The 97-2003 version should be used when you are unsure of whether or not 
someone else is using the newest version. 

Don’t be afraid to experiment, just be aware of 
which version your document is saved in.  

Look for Compatibility Mode in the title bar of 
2003 documents.  
 

If you are in doubt about whether a document 
can be converted without loss of data or changes 
in formatting, use the Compatibility Checker. In 
the Office Button menu, under Prepare, select In-
spect document. This will also tell you if there are hidden items or other ele-
ments you might not want others to see. 

NOTE: The top option under Save As - Excel Document - saves in the default 
format for Excel, 2007 (.xlsx). The default format for St. Kate’s is set to Of-
fice 2003, .xls. This can be changed in Excel Options whenever you are 
ready.  
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OPENING TEMPLATES 

Don’t underestimate how templates can help 
you. Many times what we do is repetitive; tem-
plates make your life easier, and that makes 
you more efficient. 

INSTALLED TEMPLATES are from Microsoft, 
and they are installed when Office is in-
stalled. 

MY TEMPLATES are templates that you cre-
ate and save. 

Look for RECENTLY USED TEMPLATES for 
convenient access to documents you use often. 

MICROSOFT OFFICE ONLINE has templates available to download from 
their website. Since our Internet connection is so fast, this takes no 
longer than opening a file saved on your computer or on our server.* 

NEW FEATURE!!! - NEW FROM EXISTING  

This option allows you to open an already formatted document as a new 
template, ready to delete old data, add new data without having to recreate 
the formatting. 

This opens a File Open dialog box, where you open the document as you 
normally would, except where you would expect to see an Open button, it 
now says Create New. This opens the document with your special format-

*Some templates require validation—follow the prompts to validate. This means 

that if you do not have a legally installed version of Office you will not be able to 

open these templates. 
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NEW FEATURES: 

There are many new features that 
are a part of 2007 that are not 
available in the 2003 format. 

For those who are interested, there 
is a lot more information at: 

http://office.microsoft.com/en-us/excel/HA100738731033.aspx?mode=print 

KEY TIPS - Already a fan of using keyboard shortcuts? Any shortcut you re-
member form old versions will work in 2007. For example, you always used 
the Format, and you accessed it using the old key shortcut, Alt + O. pressing 
that combination now gives you this menu. Press E and you will open the 
old Format Cell Dialog Box. Control S to save a document (my favorite), and 
any other older shortcuts can be used in Excel 2007. 

To use Key Tips, press 
Alt. This display the  
first layer of shortcut 
options.  

Press the second layer 
of command keys. If 
there are two letters, 
press them in sequence, not together. H brings you to the Home tab.  

Then, press the third layer of command keys; If you us A then C to align 
text in the center. 

SUPER GREAT NEW FEATURE:  Ctrl + Z still equals Undo, but now Excel can 
undo up to the last 100 actions! 

The following descriptions are general information. If you are familiar with 
Excel already, you can probably take this and run with it. If you are new to 
Excel, please look at the class MANAGING YOUR DATA for more complete how-
to descriptions of these great tools.  

http://office.microsoft.com/en-us/excel/HA100738731033.aspx?mode=print
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RICH CONDITIONAL FORMATTING  
Home > Styles > Conditional formatting 

In 2007 Office release, you can use conditional formatting 
to visually annotate your data for both analytical and pres-
entation purposes. To easily find exceptions and to spot im-
portant trends in your data, you can implement and manage 
multiple conditional formatting rules that apply rich visual 
formatting in the form of gradient colors, data bars, and 

icon sets to data that meets those rules. Conditional for-
mats are also easy to apply—in just a few clicks, you can 
see relationships in your data that you can use for your 
analysis purposes. 

In EXCEL 2007, Formula Writing Is Made Easier in many 

new ways. The FORMULA BAR  is now. It will increase 
automatically for longer formulas, making it easier to 

read as you are creating.  

In addition, formulas can be longer and you can use more levels of nesting, 
giving you room to breathe.  

FUNCTION AUTOCOMPLETE  allows you to write formulas using the correct 
syntax. Start by discovering functions new to you, and end with help creat-
ing formulas you already know. This also helps the ―keyboard challenged‖ 
among us from typing errors.  

To make it easier to create and edit 
formulas and minimize typing and 
syntax errors, use Formula Auto-
Complete. After you type an = 
(equal sign) and beginning letters or 
a display trigger, Microsoft Office 
Excel displays below the cell a dy-
namic drop-down list of valid func-
tions, names, and text strings 
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EASY ACCESS TO NAMED RANGES 
 Formulas Tab > Defined Names 

 
Naming your ranges allows for easier access in Formulas. You can organize 
your data and manage all of it in the new NAME MANAGER.  

Improved sorting and filtering 

Click on In Office Excel 2007, you can quickly arrange your worksheet data 
to find the answers that you need by using enhanced filtering and sorting. 
For example, you can now sort data by color and by more than 3 (and up to 
64) levels. You can also filter data by color or by dates, display more than 
1000 items in the AutoFilter drop-down list, select multiple items to filter, 
and filter data in PivotTables. 

 

Excel table enhancements 

In Office Excel 2007, you can use the new user interface to quickly create, 
format, and expand an Excel table (known as an Excel list in Excel 2003) to 
organize the data on your worksheet so that it's much easier to work with. 
New or improved functionality for tables includes the following features. 

 

Table header rows   Table header rows can be turned on or off. When table 
headers are displayed, they stay visible with the data in the table columns 
by replacing the worksheet headers when you move around in a long table. 

 

Calculated columns   A calculated column uses a single formula that adjusts 
for each row. It automatically expands to include additional rows so that 
the formula is immediately extended to those rows. All that you have to do 
is enter a formula once—you don't need to use the Fill or Copy commands. 

 

Table styles   You can apply a table style to quickly add designer-quality, 
professional formatting to tables. If an alternate-row style is enabled on a 
table, Excel will maintain the alternating style rule through actions that 
would have traditionally disrupted this layout, such as filtering, hiding rows, 
or manual rearranging of rows and columns. 
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MORE ROWS AND COLUMNS 

Excel 2007 supports more rows and columns per worksheet. If you want 
specifics, Excel 2007 can go up to 1,048,576 rows and to 16,384 columns, 
giving you 1,500% more rows and 6,300% more columns than Excel 2003. 
If you really must know, columns now end at XFD instead of IV.  

The number of worksheets is only limited by the your computer.  

OFFICE THEMES  
PAGE LAYOUT > THEMES 

Themes are new in Office 2007. A Theme is a set 
of elements that match, colors, fonts, fill effect 
and other design elements that can be used 
through Word, Excel and PowerPoint.  

You can set a coordinated design for all of your 
documents, or just for a specific item, such as a 
paper that contains spreadsheets and Word docu-
ments.  

You can also create your own custom design using your fonts, colors and 
logo, making your own theme to be used in other applications. Design and 
colors are not just for PowerPoint anymore!  

Cell styles are used to format selected cells, but you can now quickly apply a 
predefined cell style. Most cell styles are not based on the theme that is ap-
plied to your workbook, but you can easily create your own. 
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WORKSHEET TIPS: 

To add worksheets click on the Insert Worksheet button. 

Color the tabs by right-clicking 
on the tab and selecting color. 

To add or delete more than one 
tab at a time, hold down con-
trol and click on the number of 
tabs you want to add or the 
specific tabs you want to delete. 
Then right-click on one of the 
selected tabs and choose Insert or Delete.  

RIGHT-CLICK on the navigation buttons of the list of 
tabs to view a list of the worksheets. This helps when 
you are working with a long list of sheets.  

CTRL + PAGE UP —goes forward through the list of 
worksheets 

CTRL + PAGE DOWN—moves backwards through the 
worksheets. 

NAMING NOTES - Try to avoid spaces, hyphens or peri-
ods between words when naming worksheets. This will 
help Excel function better when writing formulas. Separate words with capi-
tal letters (JanuaryBudget) or underscores (January_Budget).  

This is actually a better way to name all document, espe-
cially those that might be a part of a master spreadsheet 
with links to other spreadsheets using formulas. Well, actu-
ally, it is better to use this convention when naming all 
documents whatever the type. Computers - both Windows 
and Macs - are happier without extra characters in their 
names.  


